Practice 2: Introducing to Java technology

Practices Overview

In these practices, you run a Java program, first using the DOS command line and then from the
MetBeans integrated development environment (IDE).

The practices for this course assume that the following software is installed:
» JDK1.7.0
» Java API Specification (installed locally)
» Java SET Specification (installed locally)
» MNetBeans EE Edition, 7.0.1 (GlassFish server only; Tomcat server is not used.)



Practice 2-1: Running a Java Program Using the Command Line

Overview

In this practice, you compile and run a Java program at the command line. A Java technology
program is already created for you. In some cases, you may need to first set the PATH variable
for the DOS session before running the program. Instructions for setting the PATH are included
below.

Assumptions
The Java SE 7 development environment is installed on your computer.

Task: Compiling and Executing a Java Program
In this task, you compile and execute a Java Program.

1. Compile the CalcAverage. java program. The high-level steps for this task are shown in the
table below. If you need more assistance, you can use the detailed steps that follow the

table.

2.
Step Description Choices or Values

a. Open a DOS command window and D:\labs\lesD2
navigate to:

b. Check the contents of this directory listing | CalcAverage.java
to find:
Setthe PATH variable to include: D:\Program Files\Java\jdk1.7.0\bin

d. Compile the CalcAverage java source file | javac CalcAverage.java
by typing:

a. From the Windows Start menu, select Start = Run. Enter cmd in the Open field and
click OK. At the prompt, enter cd D:\labs\le=02. Press Enter.

zoft Windows AP [Wersion 5.1.2684 ]
;opuright 1985-2801 Microsoft Corp.

b. Check the directory contents by typing dir at the command prompt. Press enter to see
the results listed.

e D is WIHNT
Humber iz FCLC-BBASY

02

641 GalcAverage.java
b4 bytes

b Y
2 Div<s> 459.428_.489.216 bytes fFree

c. Confirm that the system PATH points to the correct folder location for the Java
executables (the compiler and the runtime executable). Type PATH at the prompt and



press Enter. You should see D: \Frogram Files‘\Java'jdkl.7.0\bin appearing
somewhere in the PATH string as shown below.

s 32 sl s wwdnnt jd s swinmt s ysik

a. Ifitis not there, append this directory to the System PATH varable by entering the

following at the command prompt. Press enter.

ogram File Jdk1 .?.8%bin

You can confirm that the PATH was changed correctly by typing PATH at the next
prompt. You should see the jdk1.7.0\bin appearing at the end of the PATH string.

d. Compile the .java file by typing jawvac CalcAverage.java. Press enter. After a slight
delay the prompt will return.

D:%labs“lesB2>;j

vac CalcAverage.java

3. Runthe CalcAverage.java program. The high-level steps for this task are shown in the table
below. If you need more assistance, you can use the detailed steps that follow the table.

prompt you to enter three integers
separated by spaces. Do so and
press enter to see the average of the
three integers.

Step Window/Page Description Choices or Values
a. Confirm that the file was successfully | CalcAverage.class

compiled. List the directory content

and look for:
b. Run the CalcAverage program. lt will | java CalcAverage

a. Lookforthe compiled class, Calchverage .class, by listing the contents of the
directory again. Type dir and press Enter.

;82 >diw
Uoplume in drive D iz WINNT
Uolume Serial Numher iz FCSC-BALY

Divectory of DixlabsslesB2

<DIR>
<DIR>

721 ';..:-:‘I.J.L'rHU sage.class
641 Calch age . java
1,562 byt

23 459,428,415, 488 hytes

b. Runthe CalcAverage program by invoking the § ava runtime executable. You do not
need to use the .class extension of the class. Type java Calchverage and press
Enter. The program will prompt you to enter three integers.

D:=*lahz%1lesB2>java CalcAverage

Enter 3 Integers separated only by zspaces: {example 28 38 48>




Type three integers separated by spaces and then press Enter.

D=vlabsslesBd>java CalcAverage

Enter 3 Integers separated only by spaces: {example 20 38 48>

2 46 B8

Huerage

This is how you would compile and run a Java program using only a DOS console or terminal
window.



Practice 2-2: Running a Java Program Using NetBeans IDE

Overview

In this practice, you compile and execute a Java program using NetBeans IDE. In addition, you
explore some features of an IDE that let you develop programs more quickly and easily than if
you use a command line.

Assumptions
The NetBeans 7.0.1 IDE is installed on your computer.

Tasks
1. Double-click the NetBeans icon from your computer desktop.
2. When NetBeans opens, deselect the Show On Startup check box and close the Start
Page.
W NetBeans IDE 7.0 =1
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3. Create a NetBeans project that includes the CalcAverage.java file in its project source
folder. The high-level steps for this task are shown in the table below. If you need more
assistance, you can use the detailed steps that follow the table.

Step | Window/Page Description Choices or Values
a. Main menu File > New Project ...
b. Mew Project wizard: Choose Categories: Java
Project step Projects: Java project with existing source
Click Next
G. Mew Project wizard: Name and Project Mame: Practice02
Location step Deselect the Set as Main Project check box
Click Next




Step Window/Page Description

Choices or Values

d. Mew Project wizard: Existing Source Packages Folder: Browse to select
Sources step D:\labs)les0D2
Click Finish
e ' Prompt window Delete existing class files within the package
folder. The new project appears in the
Project's window of NetBeans.
a. Select File > New Project from the main NetBeans menu. The New Project wizard

Dpens.

In the Choose Project step of the wizard (shown in the left column), select “Java” from

the Categories column. Select “Java project with existing source” from the Projects

column. Click Next.

Choose Project

Categories:
=
) Mawven
i~ MetBaans Modules
B ) Samples

Projects:

& Java Application

&5 lava Desktop Application

iy Java Class Library

L=p |Java Project with Existing Sources |
A% Java Free-Form Project

Description:

Imports an existing Java application into a standard IDE project. The Java
applcation can have multiple source folders. Standard projects use an
IDE-generated Ant build script to bulld, run, and debug vour project,




¢. Inthe Name and Location step of the wizard, enter “Practice02" for the Project Name
and deselect the Set as Main Project check box. Click Next.

W Mew Java Project with Existing Sources

Lteps Manee and Lo ation

1 Chooss Project Specfy & name and o st For the reew project.

2. Mame and Location :

3. Ewisting Sorces Project Name: Practicenz |
&, Includes B Exclodes .
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Busid Script Hame: [buskd il ]
[[Juse Dedicated Foldar For Storing Librariss

@Sut == sir Project

= Bmclk |! FMext = Il Frush Il_ o] ][ Help ]

d. Inthe Existing Sources step of the wizard, add 0: %, 1abs" 1e=02 to the Source
Packages Folder panel by clicking Add Folder and browsing to the desired directory.
Click Finish.

Sha-jrs i shifng S ces

] Choose Project Specify the Folders contaming the souwrce packsges and Jnit test packages.

- Fharree Sined Loc o

A Emisbing Sources Zource Package Folders;

R T
Tt Package Folders:
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e. You are now prompted with the message “The specified package folders contain
compiled class files". Click Delete to delete the CalcAverage.class file that was




generated in the previous practice when you compiled the CalcAverage. java file from
the DOS console. NetBeans will generate a new class file for you in this practice.

@

W New Java Project with Existing Sources

The speciflied package folder contains compiled class files

\:t’,./ {(*.class).

Becauses the IDE generates compiled class files in
the “build” Folder, it is recommended that you delete

the exiksting compiled class files.

Do vou want do delete the class Files iowy

[ Tonore ][ Cancel ]

The contents of the project are now displayed in the Projects window within upper left
pane of NetBeans. Click the Projects tab if necessary to view the Projects window.
Here you see the project name at the root node. Expand the nodes beneath that to find

CalcAverage. java.

=& Practicad2
-0 Source Packages
=] =default package =
S0l CalcAaverage, java

+i-I g Libraries

Proj... 41 x Files - Services

Maodify the properties of this project to set the Source/Binary Format property to JDK 7. This
will allow you to use any new language features of Java SE 7 without getting an error
message from MetBeans. The table below provides the high-level steps. If you need more

details, follow the steps below the table.

Step Window/Page Description Choices or Values
Main menu File > Project Properties (Practice02)

b. Project Properties window | Source Source/Binary Format field = JDK 7
category

C. Project Properties window | Libraries | Confirm that Java 7 is listed as the Java
category Platform

d. Project properties window Click OK

a. Select File > Project Properties (Practice02) from the main menu. (Alternatively,
right-click the Practice02 project node in the Projects window and select Properties).

The Project Properties window opens.

b. Select Sources in the Categories column. Set the Source/Binary Format field to “JDK

T




® Project Properties - Practice05 &-l

Categories:
Froject Falder:  profilest Administrator|My Documents|MetBeansProjects|PracticelsS |
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S 9 Buid roe Package 5
@ Compilrg Package Folder Labsl Add Folder ..
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2 RFun
=4~ @ Application
> ‘eb Start
Formatting
Test Package Folders:
Package Folder Label Add Folder ...
Source(Binary Format: | | 10K 7 v | | Incudes/Exchides...
Encoding: UTF-8 -
[ ok || caneel |[ Hew |

Note: NetBeans allows you to specify the lowest Java platform version with which the
generated code should be compatible. For example, if you had not changed this setting to
JDK 7, you would have seen error messages when using any of the core language changes
included in JDK 7. NetBeans would warn you that the code would be incompatible with an
earlier version.

Remember that when you compiled and ran this java file from the command prompt, you had to
manually set the PATH to point to the JOK 7 installation. When you use an IDE, it automatically
sets a default JOK runtime environment for each NetBeans project

c. Confirm that the Java Platform setting for the Practice02 project is JDK 7. Select the
Libraries node in the Categories column. On the right, the JDK 7 is listed as the Java
Platform for this project. Notice that you could select a different platform (JDK version)
if you wished (assuming other platforms had been properly installed on this machine).
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d. Click OK to save the change you made in step b to the project properties.

To determine or change the default Java Platform for MetBeans, select Tools > Java
Platforms con the main menu. This window shows all versions of the JDK that have been
properly installed on this machine. In our case, only the JOK 7 (a.k.a. JOK 1.7) has been
installed so it is marked as the “Default” platform in the Platforms column. On the right, the
directory location for the JOK 7 installation is shown. Close the Java Platform Manager
window when you have finished examining it.

W Java Platform e ey

Use the Javadoc tab to register the AP1 documentation for your 10K in the IDE
Clhick Add Platform to register cther Javae SE, lava ME and JavaF platform versions,

Flatforms: - - - —
R Pt |

SIS 20K 1.7 (Defait) Flatform Folder: [ \Program Files\Javalyda.7.0 | |

Casses | Sources | Javador |

Flatform Clatspath:

D : P roge s Files) Jaealjdic] . 7 .00re’ibiresources. jar "
- WProge ain Fibes) Jay alidk ] . 7.0 re | libhrt. jar
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To view and edit the code for the CalcAverage.java file, double click it in the Project's
window. It opens in the Editor pane. Motice the color coding used by the editor. (For
example, keywords are in blue, string literals are in red.} This makes working with and
reading you code much easier. You learn more about using this editor in upcoming
practices.

In the Projects window, right-click CalcAwverage.java, and choose Compile File.

H a = I Files | Gervices || |4 CalcAverage.java x|
&-@p Practicen RE-8- QSR FPER
,_r 1|_ﬁ'j Source Packages 0 3 T cil.5 e
5-8 <defauk pac = ; import jave.util.Scanner:

o, [E——— .

i CpeEn =L 2 KEel
=t ll-ﬁ Libraries | me enter only inte

-8 oK1l cwm Crelx
gy el azs= CalcfAverage |

raske Chly

Eratic vold main

Four Fike Shift +Fé& ~Aanner =c = new Si
Debug File Ctri+Shift+FS gstem. cut.println
Profile File Fscem. out.peintcln

8. Assuming you had no compilation errors, you can now find the .class file by clicking the

Files window and expanding Practice02 > build > classes.

‘Projects !.’Hh.‘.'li 4 = Services
|_-J__,|_] Fractice0z
=D build
: =~ classes
|#] cakaverage.dass
#-IL empty
_+_I £ generated-sources
#-|& buikt-jar.properties
+-I nbproject
j: £ build.xmi
— [@) manifest.mf

= J::l ctice02 - Source Packages

P
@ CalcAverage. java

Note: If you had made any changes to the java file, the Save button would have become
enabled. By default, compilation occurs automatically with a Save.

Click the Projects window again. Right-click the file and choose Run File. The output from
the program appears in the Output window. Enter the three integer values in the line
beneath the output message and press Enter to see the result.

11



: Dutpuf - Practice02 (ﬁ.ll'l) 5 ¥ | Tasks
w ENATre

[_:1/ Enter 2 Integers separated only by spaces: (example 20 20 40)
BN 24 35 8

e

Averagas = 49
BUILD SEUCCEESFUL (tcotal time: 15 seconds)

Mow you have seen how to run a simple Java program using both the DOS command
prompt and the NetBeans IDE.

10. Close the Practice02 project in NetBeans. In the Projects window, right-click Practice02 and
select Close from the context menu.

12



Practice 3: Thinking in Objects

Practices Overview
In these practices, you first analyze a problem using object-orented analysis, and then you
design a possible sclution by using UML-like notation. Solutions for these practices can be

found inD:%1labs's5cln' les03.

13



Practice 3-1: Analyzing a Problem Using Object-oriented Analysis

Overview

In this practice, you analyze a case study and use object-oriented analysis to list the objects,
attributes, and operations in the case study.

Preparation

Read the following case study, and then model the system by choosing objects and their
attributes and operations.

Case Study
A soccer league needs a system to track team and player standings.

At any moment, administrators want to be able to report a list of games played with results, a list
of teams ranked by wins, and a list of players on each team ranked by goals scored.

Tasks

Your task is to produce an object-oriented analysis for a Java technology application that tracks
soccer scores. The program should track:

= The list of players on each team ranked by goals scored
= The list of games played with results
» The list of teams in the league ranked by wins

Hint: You can think of the objects as nouns, attributes as adjectives, and operations as verbs.
As an example, a Player is a noun, the player's name is an adjective that describes that noun,

and add goal is a verb.

The application should be able to generate statistics for teams, players, and seasons.
1. Open the text editor by selecting Start = Programs > Accessories = Notepad.
2. Savethefileas D:%labs'\les03\oo-analysis. txt.

3. To get started, list the high-level classes that are included in this problem. You can list
them in the text editor and use dashed lines to separate the objects, attributes, and
operations as shown in the screenshot.

14
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4. (Optional) You can use the UMLet tool if you choose. Double-click the UMLet icon n
from the Windows desktop to launch the program.

Solution
Player | Team Game League Goal
id id id *Team(s) id
name name team one score | *Game(s) *Team
number | *Player(s) team two score *Player
*Team *Goal time

Get ranked player | Get results Get game results
Get ranked teams

The asterisk {*) denotes atfributes that are also objects.



Practice 3-2: Designing a Programming Solution

Overview

In this practice, you continue with Practice 3-1 by using UML-like notation to represent the
classes you identified.

Assumptions

You have completed identifying the objects, attributes, and operations that you found in Practice
3-1.

Tasks

Your task is to produce a design for each of the classes in the earlier system for fracking soccer
scores. Remember to:

= Use camelCase to name your classes, attribute variables, and methods
= |dentify a valid range of values for each attribute (where a range is known)
= Use square brackets to indicate an attribute that represents a collection of values
(players[] )
= Use parentheses to identify methods
1. Open D:%\labs'les03\oo-analysis.txt and save it as
D:%labs'les03\oo-design. txt.

2. Use the classes, variables, and operations that you identified in the previous practice,
and develop method names for the operations. The screenshot below is an example.

e
tunnber
temn

Team

id
e
plavers]

selRankedPlavers()

TS R, W \h-._-_‘.__“'\;“‘l_‘.‘h\—._‘ e Ty
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3. ([Optional) You can use the UMLet tool if you choose. Double-click the UMLet icon n
from the Windows desktop to launch the program.

LUALe - Fres Ul Toal for Fast LWL Diggiass
Fir Edd CuslomBererds ek Seath Toowr | 1007 = Ml chogy e
rare = |t -
[t | [le] O —— i
o Ly = o heas
., | T e
[Sore Prapedie)]
T :
B T
Pagsc -1 D
id Fosponsmates | w--==—-=--
rams _:::,,,-, T SR T This i @t
I';::r:l {.'E""L'E"'.“_'L“:.'.. T
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Flager
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- -y
id
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"Playen’s]
el ranked plyys
LRSI, N A _\.._'—"'\\ bt TP S "'-'.\ A T T, ol Rl
Solution
Player Team Game League Goal
id id id teams| | id
name name team one score | games| | team
number | players[] team two score player
team goals[ ] time
getRankedPlayers() getResults() getGameResults()
getRankedTeams()

Note: Although not shown in the solution, you need add/remove methods for each
collection attribute and get/set methods for all other attributes. We hawve not discussed
those methods at this point in the course.

Your solutions might look different from the suggested solution. The purpose of this lesson is to
help you continue thinking in terms of objects, attributes, and operations. You have another
opportunity during this course to practice modeling a programming solution.



Practice 4: Introducing the Java Language

Practices Overview

In these practices, you examine and modify existing Java programs and also run them to test
the program. Solutions for these practices can be found inD: % 1labs'scln' les04d.
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Practice 4-1: Viewing and Adding Code to an Existing Java Program

Overview

In this practice, you are given a completed Java program. You open it, examine the lines of
code, modify it. compile it. and then test it by executing the program.

Assumption

s

s  Quotation.java and QuotationTest.java appear in the folder for this practice:

D:h1

Tasks

abs'\les04

1. Create a new project from existing Java source, just as you did in Practice 2-2. The high-
level steps are shown in the table below. If you need further detail, refer to Practice 2-2,

steps 3and 4.

Step Window/Page Description Choices or Values

a. Menu File = New Project
Mew Project wizard | Choose Project | Category: Java
step Project Java Project with Existing Sources

Next

c. Mew Project with Existing Sources Project Mame: Practice04
wizard | Name and Location step Next

d. Mew Project with Existing Sources Add Folder: 0: % 1lakbs' 1les04
wizard | Existing Sources step Finish

e Project Properties window | Source Source/Binary Format: JDK 7
category OK

Note: The Projects window should now look like this when the <default package®> node is
expanded:

Projects

4 = Files ‘Services

=8

|

= & Practice0d

Sowrce Packages

[ «defaul: package=
-] Quotation.java
W QuotationTest, java

Libraries

2. Double-click the guotation.ava file in the Projects window to open it for editing.
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Identify the field and the method contained within this class, using the table below:

Member Variable or Name

Field variable:
Method name:

o

Solution: Field variable — quote; Method name — display.

In the display method, write the code to display the quote field. Hint: Use the
System.out. print 1n method shown in the Student Guide for this lesson. Be sure to
finish the line of code with a semicolon.

Note: You will notice, as you type the code, that NetBeans' code assist feature provides
feedback and help whenever you pause in your typing. For instance, if you stop at some
point at which the code, as is, would not compile successfully, it displays a red exclamation
mark in the left margin. If you pause after typing the dot (") following System or cut, it
gives you context sensitive help in the form of a list of methods and fields that would be
valid for the particular class to the left of the dot. You can select from the list instead of
typing.

Solution:
System.out.println(guote);

| Quotation.java |

RE-H-ARHEFe? A 60 & 1
public class (Quotation |
public String guote = "Welcome to Oracle, the new home of Java!™

display the member wvariable here

System. ori.printlnigquote) ;

1
g
3
i
g public woid display () |
&
7
g
9

H

Click the Save button to save and compile Quotation_java.

Open the QuotationTest.java file in the editor and examine its main methed. It creates an
instance of the Quotation class and then calls its displ ay method.

Run the QuotationTest class by right-clicking QuotationTest.java in the Projects window
and selecting Run File. The output from the display method appears in the Output window.

MNote: You were able to skip the Compile step because when you select Run File,
MetBeans first compiles not only the class you selected to run, but also any referenced
classes within that class (Quotation. java).

:Dutput - Practice04 (run) ¥ x [_Tukg

u) Eu

[:.;/ Welcome to Oracle, the new home of Jawval
BUILD SUCCESSFUL (total time: 0 seconds)

=

Edit the Quctation. java file now to change the default value of the quote field.




9. Run QuotationTest again to verify the output.
10. Inthe Editor pane, close Quotation.java and QuotationTest. java.
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Practice 4-2: Creating and Compiling a Java Class

Overview

In this practice, you create a Java class and compile it. You also create ancther Java class to
test the previous class.

Assumptions
Mone

Tasks
Create a new Java class in the Practice0d4 project using the MetBeans wizard. The high-

1.

level steps for this task are shown in the table below. If you need more assistance, you can

use the detailed steps that follow the table.

Step Window/Page Description Choices or Values
Menu File > New File
b. Mew File window | Choose File Type | Category: Java
step File Types: Java Class
Next
c. Mew Java Class window | Mame and | Class Name: shirt

Location step

Finish

a. From the main menu, select File > New File.

b. The Mew File wizard opens and you are on step 1 “Choose File Type". Select Java in
the Category column. Select Java Class in the File Types column. Click Next.

Choose File Type

Project: | &p Practice04

Cateqories:
S lava
<) Swing GUT Forms
) JavaBeans Objects
) AWT QUL Farms
120 Mnit
<) Persitence
) Hibermate
1 ML
) Other

FEEEEREEEEEEE &

Descripbion:

Creates a new plain Java class. This template is useful for creating new non-visual

classes,

Twpes:

Java Interface

Jawva Enun

Java dnnotabion Type
Java Exception

Java Package Info
Japphat

Applet

Java Main Class
Java Singleton Class

Empty

Java Package

lava File
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¢. Inthe New Java Class window, you are on step 2 *“Name and Location”. Enter “Shirt”
as the Class Mame. Click Finish.

Mame and Location

Class Name: | Shirt

Project: Practice0s
Locaticn; Source Packages w
Package: w

Creaated Fils; |D:\labs\ess04\Shirt java

8 Warning: It is highly recommended that you do NOT place Java

[ Firiish ” Canicel J[ Help j

The Java source file for the new class now appears in the editor ready for you to fill in
the details.

Enter the Java code syntax for the Shirt class shown in this lesson of the Student Guide.

Solution: You can find the solution code for the Shirt class inD: % 1laks'scln' les04

Click the Save button to save and compile the Shirt class. Any red error icons in the left
margin should disappear after saving if there were no compilation errors. If necessary, fix
any errors that appear in the Output window and save again.

Note: The MNavigator pane (lower left comer of NetBeans) for the shirt class now shows
the Members view of the class. MNotice the color coding that distinguishes between fields
and methods. Both of these are considered *Members” of the class.
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Members View w
=gy Shirt

- o displayInformation])

i [ colorCode @ char

[ description : String

~ & price : double

=[] guanbiyInStock : it

o [ shirtID ik

Follow the instructions from Step 1 to create ancther new class. This will be a Test class, so
it will need a main method. To accommodate that change, the table below shows the
substitutions in the Step 1 instructions you should make as you go through the Mew Class
wizard. For more detail, see the screenshots following the table.

Step Window/Page Description Choices or Values
a. MNew File window | Choose File Type File Types: Java Main Class
step
b. Mew File window | Name and Location | Name: ShirtTest
step

a. Inthe Choose File Type step, select Java Main Class instead of Java Class.

Choose File Type

Project: | & Practicedd -
Categories: File Types:
i Java | & 1ava Class
) Swing GUT Forms & Java Interface
-_"i JavaBeans Objects @ Java Enum
) AWT GUI Forms 1 Java Annotation Type
23 Mnit [ Java Exceplion
i Java Package Info
j Persistence & Japplet
) Hbemnate ZE Acolet
- M Q‘; Java Main Class
- Other & lava Singleton Class
| Empey Java File
] lava Package
Description:

Creates a new Java class with a main method permitting ittoberunas  ~
a console application. If you want to design a visual application, you
might prefer o use the JFrame template under Java GUI Forms, or an
application skeleton undwd Java GUL Forms | Sample Forms.
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b. Inthe Mame and Location step, enter ShirtTest as the name.

Mame and Location

Class Mame: :ShitTest

Project: Practice04
Loscation: Source Packages w
Package: v

Created File:  D:\abs\les04) Shirt Test. java

5. Replace the To Do: comment in the ma in method with the two lines of code that appear in
the ma in method for the ShirtTest class shown in this lesson of the Student Guide.



Solution: You can find the solution code for the Shirt Test class in
D:%1labsisolnlles04

10 public class ShirtTest |

11l ;e

]_2 x iparam ardgs The COmRl d line argquments
13| - b

1a|=] public static void main(String[] acgs) |
15 Jhirt myS3hire;

16 mwyShire = new Shirc():

17 wyShirc.displayInformation() :

18| - b

19 i

6. Save and compile the code by clicking Save.

7. Run the ShirTest class by right-clicking ShirtTest.java in the Projects window. Look for the
output of the displayInformaticon method in the Output window.

‘Dutput - Practiced4 {run) ¥ = 'Tasks

nim:

Shirtc ID: O

Shirt description: -description regquired-
Color Code: T

Shirt price: 0.0

Juantity in stock: 0

BEUILD SUCCEZSSFUL (total time: 0 seconds)

H BT

8. Find the class files that were generated by NetBeans when you ran the program. Click the

Files tab to open the Files window and find Shirt.class and ShirtTestclass as shown below.

Projects ‘Files 1l x |: Services
=) Practice0d
=103 build
=) rclasses
@ Ouokation.class

[#] OuotationTest,class
(2] shirt.class
; 8] shirtTest.dass
+-/_) nbproject
F4]  build sl
E [] manifest.mf
[#+_J) Practice0q - Sowrce Packages

9. Open (or retum focus to) the Shirt . java file. Modify the values of ShirtIDand price.

10. Run the ShirtTest class again. Verify that the modified values are shown in the Output
window.
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Practice 4-3: Exploring the Debugger

Overview

Virtually every Java IDE provides a debugger. They tend to offer the same core features and
work very similarly. In this practice, you debug the ShirtTest program using the NetBeans
debugger. You set breakpoints, examine field values, and modify them as you step through
each line of code.

Assumptions

MNone

Tasks

1. Set a breakpoint in the ShintTest class. Click in the left margin of the editor, next to the
following line of code:
myShirt = new Shirt(};

A pink square appears in the margin, indicating a breakpoint.

14
15

©®©

17
13

public static vold maeir(3tring[] arcgs) 1
Shict myShirc:
myShirt = new Shirc():
myShirc.displayInformation () ;

i

2. Runthe debugger by right-clicking on the ShirtTest file in the Projects window and selecting
Debug File.

3. The debugger starts the program and stops at the breakpoint. In the Editor panel you
should now see a different icon that points with a green arrow to the line of code.

141
15

18| *

public static vold madn(String[] args) |
Shirt myShirt;
mwyShirt = new Shirt():
wyShirt.displayInformationi) :

}

This line of code has not yet been executed.
4. Sewveral other changes have occurred in the NetBeans window.

» A new toolbar appears, containing buttons that you use when debugging.

0O O & & &5 i

Move your cursor over each of the toolbar buttons to read the toolbar tip explaining
what each button does. The buttons are described below.

The first button, Finish Debugger Session, stops the debugging session.
The second button, Pause, pauses the execution of the debugger.

The third button Continue the execution, either to the next breakpoint or to the
end of the program.

The fourth button, Step Over, moves the program forward to the next line of
code in the current class (in this case, the ShirtTest class).

The fifth button, Step Over Expression, allows you to step over an entire
expression to the next line of code in the current class.
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— The sixth button, Step Into, allows you to step into another class referenced in
this current line of code.

— The seventh button, Step Out, allows you to step back out of a class that you
stepped into.

— The last button, Run to Cursor, takes execution to the line of code where the
CUrsor appears.

= The panel at the bottomn of the window changes to show debugging output and
variables and other useful information during a debug session.

|:Variables ¥ = Breakpoints | Dutput | Tasks
o~ Name Type oy
IE/_. <E !"II-" watch D
1+ T Static E]
@ I "\':’urlzs Sring[] E] #53{length=0)
L2
v N

[

— Inthe Variables panel, you see all variables that are visible to the current class.
Remember that the execution was stopped before the Shirt class object has been
instantiated. Consequently, you do not see the myshirt varable in this panel.

Click the Step Over button to mowve to the next line of code. m

The arrow now points to the line of code that calls the displayInformation method on
the myshirt object. In the Values window, you now see the myshirt varable. Expand it
to see all of the fields of this shirt object.

14[-] pubblic static void main(3cring[] args) |
15 Shirt myShire;

= myShirt = new Shirt():

L= I wyShirt.displavInformation() 2

18 - B

19 }

At this point, the displayInformation method has not yet been executed. You could
change the values of the object's fields right now, using the Variables window if you wanted
to. However, instead, you “step into” the myshirt object and change the values during the
execution of the displayInformation method.

&

Click the Step Into button to step into the displayInformation method.
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8. The arrow icon is pointing to the first executable line of code within the
displayInformaticn of the shirt class. Inthe Varables window, expand this to see

the fields of this object
15 = public void displayInformation(){ b
o System. cut.println("Shict ID: "4 shirtID):
21 Jyscem. cut.prineln("Description: "+ description): —
22 Syscem, out.princln("Color Code: "4 colorcode] :
23 Syatem. cut.println("Price: "4 price):
24 Jystem. cul.println("Quancicy in stock: " + guantityIndcock) ; o
< >
“variables ¥ = | preakpoints | Dutput Tasks
& | Mame Type Walue
L1
@ cEnter new wakch [:l D N
o O 0
[ @ shirtID int [Jo (]
Lﬂ @-dasu"ptiun Skring [:I *-description required-" D
@) | @colorode char [Jv (]
@ price double [:l 0.0 D
@ quantityInStack ink [Jo (]
|
8. Inthe Value column double-click each field's value and edit it to change the value. Ensure
that you use the correct value for the data type expected and enclose any character data
types with the type of quote mark indicated. After editing the final field, click the tab button
s0 that the text you typed into the edit buffer is accepted.
‘Yariables Fx ]_ﬂredcpnlnn .El:lul:pul: " Tasks
g‘; Mdarne Type ‘alue
& | IR N
— = @ this Shirt #58
| @ shinw nt BE
[ @ desaripbon String E] “T Shirt"
@ @ colorCode char E] 2y
@ price double D 15.0
@ quantitylnStock nt BE
10. Click the Step Out button to return to the next line of code in the ShirtTest class. The
displayInformation method will have completed.
14 public static void main(3tring[] args) {
15 Shirt myShirt:
= myZhirt = new Shirec():
17 myShirc.displayInformation() ;
= H
11. Motice that the myShirt object field variables reflect the changes you made while in the

method.

12. Click the Continue button now to finish execution and end the debug session.
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13. Click the Output tab to view the output.
: Dutput ¥ x :Tasks

Practice04 (debug) = | Debugger Console x

debnag:

Zhirt ID: 1

Zhirt descriptiomn: T EZhirt

Color Coda: R

Shire price: 15.0

Quancity in stock: 3

EUILL SUCCESSFUL (cotal time: 1 minutce 3 seconds)

R T e

You have now experienced some of the most commonly used features of a typical IDE
Debugger. You may wish to use the debugger in remaining labs to help you diagnose and fix

problems you may experience in your programs.
14. Close the Practice04 project in NetBeans. In the Projects window, right-click Practice04 and
select Close from the context menu.
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Practice 5: Declaring, Initializing, and Using Variables

Practices Overview

In these practices, you create several Java classes that declare, initialize and manipulate field
variables. Solutions for these practices can be found inD: % 1labs'scln' les05.
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Practice 5-1: Declaring Field Variables in a Class

Overview

In this practice, you create a class containing several fields. You declare the fields, initialize
them, and then test the class by running the CustomerTest program.

Assumptions

This practice assumes that the CustomerTest Java source file appears in the practice folder for

this lesson: D: % 1laks' 1les05

Tasks

1. Close any open project in MetBeans. In the Projects window, right-click the project name

and select Close from the context menu.

2. Create a new project from existing Java source, using the values in the table below when

you complete the New Project wizard.

Step Window/Page Description Choices or Values
a. Choose Project step Category: Java

Project Java Project with Existing Sources
b. Mame and Location step Project Name: Practice05

Existing Sources step

Add Folder: ©:%1abs'1es05

Project Properties window

Set the Source/Binary Format property to
JOK 7

Mote: If you need a more detailed reminder of how to create a new project, refer to Practice

2-2, steps 3 and 4.

package> node.

Solution: The Projects window should show four Java source files beneath the <default

‘Projects 41 x Files

: Services

= & Practicens
=g Source Packages
=- <defauk package=
gy CustomerTest java
o OrderTest.java
o PersonTest java

o TemperatureTest, java
*-I[@ Llbrares
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Create a new Java class. The table below provides the high level steps. if you need more
assistance, refer to Practice 4-2, step 1.

Step Window/Page Description Choices or Values
a. Menu File > New File
b. Mew File window | Choose File Type | Category: Java

step File Types: Java class

Next

C. Mew Java Class window | Mame and | Class Mame: Customer

Location step Finish
‘Projects 4 x Files | Services
=& Practiceds

=g Sowrce Packages
| = G| «default package>
E] Customer, java
~ gy CustomerTest.java
g OrderTest.java
&, PersonTast, java
gl TemperabureTest java

+-I@ Libraries

With Customer.java open for editing in the Editor pane, declare and initialize the fields
described in the table below. If you need more assistance, more detailed steps are provided
following the table.

Field Name Data Type Default Value
customerlD int =your choice=
status char =your choice=
‘W' for new, ‘0" for old
totalPurchases |double 0.0

a. The syntax of a varable declaration and initialization is:
modifier type wvariable = <value>;

b. Assume that all fields are public.

c. Include a comment at the end of each line describing the field.

Solution: This shows one possible solution for the customer ID declaration and
initialization. The others are similar.

|pub1i:: int custcmerID = 0; [/ Default ID for a customer |

Add a method within the Customer class called displayCustomerInf o. This method
uses the System.out . println method to print each field to the screen with a
comesponding label (such as “Purchases are: “).
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Solution:

public void displayCustomerInfo [} {
System.cut.println (“Customer ID: ™ + custcmerID);

J/ continue in a similar fashion for all other fields

}

Click Save to compile the class.

Note: You will notice that the red error indicator next to the CustomerTest class in the
Projects window disappears after saving the Customer class. The reason is that the
CustomerTest class references the displayCustome rInf o method, which did not exist
before you saved the file. NetBeans recognized a potential compilation error in the
CustomerTest class, due to the missing method.

Run the CustomerTest class to test your code. If you are prompted with a warning
indicating that there are compilation errors within the project, click Run Anyway.
—

® Run Project

'
A One or more projects were compiled with errors.
application you are running may end unexpectedhy,

[ ] Bbiarys run skhiout asking

[ Rur Arywaay ll[ Cancel

Note: All of the examples and practices in this course require a test class. In most
situations, the test class is provided. However, in some situations, you create the class.

8. Check the output to be sure that it contains the values you assigned.

S Oukput - Practice05 (run) ¥ = | Tasks
Euta:

Customer ID: 0

Status: N

Purchases: 0.0
BUILD SUCCESSFUL {total time: 9 minutes ll seconds)

A RAzZ
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Practice 5-2: Using Operators and Performing Type Casting to
Prevent Data Loss

Overview

In this practice, you use operators and type casting. This exercise has three sections. In each
section you create one Java class, compile it, and test it.

Assumptions

The following Java source files appear in the practice folder for this lesson: D: % 1labs' les05
« PersonTestjava
* OrderTest java
s TemperatureTest.java

Calculating Age Using Operators
In this task, you use operators to calculate age in days, minutes, seconds, and milliseconds.
1. SelectFile > New File from the menu to create a new Java class called Person.

@ Person, java = |

RE-F- QAR LER G

C
I
i
i,

(]

I'o change thils ctemplace, choose Tools lemplaces

AT pen the emplace the ed

2 =) & A o W =
ol

faunthor Admini rato

L=
T

1o public class Persom |
11

12 }

13

2. Using the editor, add the following fields to store age in years, days, minutes, seconds, and

milliseconds. Provide meaningful names for all the fields. The table below provides more
detailed information:

Year Part Data Type Additional Info
Years int Initialize to 1
Days int Do not initialize
Minutes long Do not initialize
Seconds leng Do not initialize
Milliseconds leng Do not initialize

Hint: You can declare multiple variables of the same type in one line by separating the
variables by a comma. Be sure to end the line with a semicolon, just as you would any
other line of code.
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3. Create a new public method in this class called calculatenge.

a. The method should calculate age in days, minutes, seconds, and milliseconds,

assigning the value to the relevant field. The following table gives you the calculations:

Year Part Calculated By:
Days Year* 365
Seconds Days ™ 24 * 60 *60
Minutes Seconds [ 60
Milliseconds Seconds * 1000

b. Printout all the ages in various units, each in a separate line with an appropriate
message. For example “You are 3156000 seconds old.”

Solution:

ageSeconds =

ageMinutes =

}

public wveoid calculatelge

ageMilliseccnds

{

ageDays = ageYears * 365;

ageDays * 24 * 60 * &60;
ageSeconds [ &0;
ageSeconds * 1000;

System.cut.println ("You are " + ageDays + " days cld."};
System.cut.println ("You are " + ageMinutes +
" minutes old.") ;
System.cut.println ("You are " + ageSeccnds +
" geconds old.") ;
System.cut.println ("¥You are " + ageMilliseconds +

" milliseconds old.") ;

4. Saveto compile the class and then run the FersonTest . Java file.

5. Perform several tests, by setting the value of age as 1, 24, and 80 in the Person class.

Solution:

For one year, the results should be: You are 365 days old. You are 31536000 seconds
old. You are 525600 minutes old. You are 31536000000 milliseconds old.

Using Casting to Prevent Data Loss

In this section you use casting to ensure that data loss does not occur in your programs.

6. Create a new Java class called oxrder
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7.  Add three fields to the Order class as follows:

Field Name Data Type Initialized Value
crderValue leng OL (zero L)
itemDuantity int 10_000_000
itemPrice int 555 500

Mote: The underscores used to initialize the int values improve the readability of your
code. They have no effect on the actual numeric value of the field. The compiler strips them
out This is one of the new language features of Java 7.

8. Create a calculateTotal method that calculates the total order value (itemQuant ity ™
itemPrice)and print t. Be sure to type cast either i temQuantity or itemPricetoa
1long so that the temp storage used to hold the outcome of the multiplication is large
enough to contain a long value.

Solution:
public void calculateTotal () {
crdexValue = (long)itemQuantity *# itemPrice;
System.cut.println (*0rder tctal: "+ crderValue);

9. Save Order. java and then test it by unning OrderTe=st . java. Verify the result by using
a calculator.

|Solution: Result should be 5555000000000 |

10. Edit the order. java file to remove the type casting done inthe calculateTotal
method.

11. Compile and run OrderTest again to see the resulting data loss that ocours without type
casting.

Creating a Temperature Program
In this section, you write a program to convert temperature from Fahrenheit to Celsius.

12. Create a new Java class called Temperature. Add a member field to the Temperature class
that stores the temperature in Fahrenheit. Declare the field variable with an appropriate
data type, such as int, f leat, or double.

13. Create a calculateCelsius method. Convert the Fahrenheit temperature to Celsius by

subfracting 32, multiplying by 5, and dividing by 9. Be sure to observe the rules of
precedence when typing this expression.

Hint: The rules of precedence are listed here for your convenience.
»  Operators within a pair of parentheses
« Increment and decrement operators
*  Multiplication and division operators, evaluated left to right
» Addition and subtraction operators, evaluated left to right
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14.

15.
1B.

Solution: This is one possible solution.

public class Temperature |
public flcat fahremheitTemp = 78.3F;

public wvoid calculateCelsiusi) {
System.cut .println ( (fahrenheitTemp - 32) * 5 / 9);

Compile the Temperature class and test it using the TemperatureTest class. Confirm that
you get the same result running the program as you do when doing this calculation using a

calculator.
Test the program using several values of temperature.

When you have finished experimenting with different values, close the Practice05 project.
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Practice 6: Working with Objects

Practices Overview

In these practices, you create and manipulate Java technology objects and also create and use
String and StringBuilder objects. In the last exercise, you become familiar with the Java API
specification. Solutions for these practices can be found in D: % 1labs'soln' le=s0E.
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Practice 6-1: Creating and Manipulating Java Objects

Overview

In this practice, you create instances of a class and manipulate these instances in several ways.
This Practice has two sections. In the first section, you create and initialize object instances. In
the second section, you manipulate object references.

Assumptions
The Customer. java file appears in the practice folder for this lesson: D: % 1labs" le=06

Initializing Object Instances

A Customer class is provided for you. In this section, you create, compile, and execute a

CustomerTest class. In this test class, you create objects of the Customer class and set values

to its member fields.

1. Create a new project from existing source called Practice06. Set the Source Package
Folder to point to D: % 1labs" 1es06. Remember to also change the Source/Binary Format
property. If you need further details, refer to Practice 2-2, Steps 3 and 4.

‘Projects 40 = :Files - Services
= @ Practice0&
gl Sowrce Packages
=
&5 Customer java
;Eﬂ PersonTwoTest, java
+- @ Libraries

2. Open the Customer.java file in the editor and examine its member fields and its method.
You use the field infformation to complete this practice.

3. Create the CustomerTest class as a “Java Main Class” type. Since this class is run
(executed) by the Java executable, it must contain a main method. The NetBeans IDE
provides the skeleton of a main class for you.

a. Right-click the Practice06 project in the Projects window and select Mew > Java
MainClass from the popup menu. (This is a shortcut way of creating new Java
classes.)
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b.

C.

Mame the class CustomerTest and click Finish.
W New Java Main Class

Skeps Narme and Location

%)

1. Choose File Type Class Name: |CustomerTest

2. Name and Location

Project: Practicelt
Location: Source Packages
Package:

Created File:  D:\labsiles06)Customer Test. java

Help |

The CustomerTest class appears in the text editor.

) CustomerTest.java x|

J_:[v-;_- QATHE P @
1B ¥-

2 o change this template, choose Tool:

lanthor Administrator
10 public ¢lazs CustomerTest |

12 = FEE

13 ¥ @param args the commwand line arguments
14 -
15 [=] publie =racic void main(Scring[] args) {
16 £ TODD code applicatcion logic here

18 +
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In the main method of CustomerTest, add code to declare and initialize two instances of
the Customexr class. The table below provides high-level instructions for this task. If you
need more assistance, refer to the detailed steps following the table.

Step Window/Page Description Choices or Values
a. Declare two fields of type Customer | custl

cust2
b. Initialize the two instances Use the new operator

a. Within the body of the main method, declare two fields of type Customer as follows:
Customer custl, custi;
b. Initialize each of the variables using this syntas:

cyvariable name> = new =zclass names=();

Finish coding the main method as indicated in the following table. More detailed
instructions are provided below the table.

Step Window/Page Description Choices or Values
a. Assign values to the member fields Example:
of one of the Customer objects custl.customerID = 1;
b. Repeat for the other Customer
object but use different values for the
fields.
C. Invoke the displayCustomerInfo | Use the object reference varable to qualify the
method of each object method as you did in step a.

a. Assign values to all of the member fields of one of the Customer objects. Use the
object reference variable to qualify the field name as shown below:
custl.customerID = 1;

Assign different values to each member field of the other Cust omer object.

c. Invoke the displayCustomerInfo method of each object. Example:
custl.displayCustomerInfc();

Click Save to compile.

Run the CustomexrTest . java file. Check the output to be sure that each Customer object
displays the distinct values you assigned.

‘ Dutput - Practice06 {run) ¥Fox

arc

FEEEETETiustomer Informaciop™rTrss=®
Customer ID: 1

Name:Hary Smith

fD®©

Email: mary.smith@ymail.com

b2 et b bt E s n b b b a b b g bt bt b b b b
FEwewrxrCustoner Information®¥*vssss
Customer ID: 2

Hame: Frank Jones

Emsil: frank. jonesflgmail. com

FEFTEEETETELTE L E T E T TR TR TR T AT T TSI E A E L RS

BUILD SUCCESSFUL (total time: 0 seconds)




Manipulating Object References
In this section, you assign the value of one object reference to another object reference.

8.

Edit the main method of CustomerTest to assign one object reference to another object
reference just above the first line of code that invokes the displayCustomerInfo
method. For example (assuming that cust 1 and cust 2 are instances of the Customer
class):

cust2 = custl;
Save and run the CustomerTest.java file. Check the output of the
displayCustomerInfo methods for both objects. Both of the object references now point
to the same object in memory so both of the displayCustome rInfo method outputs
should be identical.

Ll
®

‘Dutput - Practice06 {run)

T

t;’ *rErxrETfustoner Information® s+ sss®

Customer ID: 1
] Name:Mary Smith
a% Email: mary.smithgmail.com

LA b b s b b bt b b b s bt s bt b b b b bttt b
wekrksksCpstoner Information**svssss
Customer ID: 1

Hame:Mary Swith

Emsil: mary.smithf#imail com

FEETEFTEETETLTETE LT LT E LT T T T TR AT AT T AL L

BUILD SUCCESSFUL (total time: 0 seconds)
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Practice 6-2: Using the StringBuilder Class

Overview
In this practice, you create, initialize, and manipulate StringBuilder objects.

Assumptions
The PersonTwoTest . java file appears in the practice folder for this lesson: D: % labs' les06

Creating and Using String Objects
1. Create a new Java class called “PersonTwo™.

2. Declare and instantiate two member fields of type 5t ringBuilder to hold the person's
name and phone number, respectively. For the name field, initialize the capacity of the
StringBuilder objectto 8. Use meaningful field names.

Example Solution:

public class PersonTwo |
pukblic StringBuilder name = new StringBuilder (8} ;

pubklic StringBuilder phoneMNumber = new StringBuilderi});

}

3. Create a new method called “displayPersoninfo”.

4. Inthe body of the displayFersonInfo method, populate and then display the name
object. Ensure that the total number of characters in the name exceeds the initial capacity
of the object (8). The following table provides high-level steps for this task. More detailed
instructions can be found below the table.

Step Window/Page Description Choices or Values
a. Add a first name to the Use the append method of the
StringBuilder object StringBuilder class
b. Append two more values to the aspace: "
name object alast name

MNote: The total number of characters
appended should exceed 8

c. Display the st ring value of the Use the to5tring method of the
name object StringBuilder class

d. Display the capacity of the names Use the capacity method of the
object with a suitable label StringBuilder class

e Compile and run the program Run the PersonTwoTest.java file

a. WUsethe append method of the St ringBuildexr class to append a first name.
Example:
name.append [ "Fernandc” | ;

b. Use the same method in two separate invocations to add first a space (" *), and then a
last name. Ensure that total number of characters that you have added to the name
object exceeds 8.
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Note: You can accomplish the same thing by using a String object and concatenating
additional values. However, this would be inefficient because a new String object is
created with each concatenation. String object capacity cannot be increased as Strings
are immutable.

Use the System.cut print 1n method to display the entire name value. You can
embed the toString method of name object within the System.cut println
methed.

System.cut.println("Name: ™ 4+ name.tocStringl());

Display the capacity of the name object, using the capacity method. The

St ringBuildexr object has dynamically increased the capacity to contain all of the
values that you have appended.

Example Solution:

a.

public void displayPersonInfol){
name.append [ " Fernando”) ;
name.append (* "} ;
name . append [ “Gonzalez") ;
// Display the name chject
System.cut.println ("Name: + name.tcStringl(l);
// Display the capacity
System.cut.println ("Name cbject capacity: " +

name . capacityi));

}

Click Save to compile. Run the PersonTwoTest . java file. The output should look
similar to the screenshot below. Motice that the capacity has been increased from the
initial setting of 8 to accommodate the full name.

‘Dutput - PracticeD6 {run) F x
D [z
LE’ Name: Fernando Gonzalez
Name object capacicy: 18
B8 |EUILD SUCCESSFUL ftotal time: 0 seconds)

=
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Populate and manipulate the phonelNumber object. Here you append a string of digits and
then use the insert method to insert dashes at various index locations, achieving the
format “nnn-nnn-nnnn”. The table below provides high-level instructions for this task. More
detailed instructions can be found below the table.

Step Window/Page Description Choices or Values

a. Append a 10 digit St ring value to Example: "5551234567"
the phonelumbe r object

b. Insert a dash ("-*) after the first three | Use the insert method that takes an int
characters of the phonellumber. value for the offset and inserts a String

value. (Use offset number 3)

C. Insert another dash after the first Reminder: The previous insertion pushed the
seven characters of the remaining characters over one index.
phonelNumber

d. Display the phonelNumber object Use the toString method of the

StringBuilder class

a. Usethe append method of the 8t ringBuilder class to append a String value
consisting of ten numbers.
b. Inserta dash (*-*) at offset position 3. This puts the dash at the 4 position in the String,

pushing all of the remaining characters over one position. The syntax for this method is
shown below:

<cbject references.insert(int cffset, String str);

Example: Consider the following string,
‘6551234567
The offset position 3 occurs at the number 1. (Index numbers begin at0.) If the dash is

inserted at offset position 3, it pushes the number currently at that position and all
remaining numbers over to the next offset position.

¢. Insert a dash at offset position 7 (where the number 4 is currently placed).

d. Use systemout.println todisplay the output from the StringBuilder object's
toString method.

Solution:

phonelumber. append ("5551234567") ;
phoneNumber. insert (3, "-");
phonelumber. insert (7, "-");

System.cut.println ("Phone number: " +

phoneNumber. toString () ) ;




Click Save to compile. Run the PersonTwoTest . ava file. Check the output from the
displayPersonInfoc method. Ensure that the dashes appear between the third and
fourth digits and between the sixth and seventh digits.

:Dutput - Practice06 {run) Fox

B | o

w Name: Fernando Gonzalesz

Name object capacity: 18
| Fhone rumber: 555-123-4557
%& EUILDI SUCCESSFUL itotal time: 1 second)

Use the substring method of the StringBuilder class to get just the first name value
in the name object. Use the substring method that takes the start index and the end
index for the substring. Display this value using System.out println.
Syntax:

<cbject references.substringiint start, int end);

Mote: Indexes for characters in the StringBuilder class, much like array indexes, are
zero-based. The first character in the StringBuilder is located at position (or index) 0.
While the start index of the subs tring method is inclusive (it is the actual index of the
first character you want retumed), the end index is exclusive (it is the index of the
character just to the right of the last character of your substring.)

Example Solution:

S hssumes the first name "“Fernando”

System.cut.println("First name: ™ + name.substring(0,8));

Save and again run the FersonTwoTest.java. Check the output and make any
adjustments necessary to the index numbers to get the correct first name value.

‘Dutput - Practice06 (run) Fx
w‘ Fr
Ll-;/\' Name: Fernsands Gonzsles
Name object capacicy: 18
| Phone number: 555-123-4E867
First Mame: Fernando |
BUILD SUCCESSFUIL (total time: 0 seconds)
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Practice 6-3: Examining the Java API Specification

Overview

In this practice, you examine the Java API specification to become familiar with the
documentation and how to look up classes and methods. You are not expected to understand

everything you see. As you progress through this course, the Java AP| documentation should
make more sense.

Assumptions
The Java SE 7 API specification is installed locally on your machine.

Tasks

1. Toview the Java SE7 API specification (also referred to as *javadocs”), double-click the
shortcut on your desktop (entitled “Java JOK7 1.7.0 APl Docs").

Java™ Platform

(nandew | Fackage Class Wee Tree Deprecated Index Hslp

St'ﬂnd al.-d Edt ? Praw  MNast Framas Mo Framas
All Classes Java™ Platform, Standard Edition 7
API| Specification
Packages
This documeant is the AP specification for the Java™ Platform, Standard Eddion

* Java applet -

< ) ol See: Descriplion

Eal —
All C1 .
1ASSes Packape Description
Jva.appHet Provides the classes nace
¢ Abstractiction _ v Contains all ofthe classes
: Abma[mmfumr':ia]mvﬁnm Jrva.awd.color Privides classas for color
Mmm—mw ; n

* AhctractBordar vt anstel Provides interfaces and clg
* AbstraciButton jrvaamt.dnd B e
® AbetractCellEdtor machanism 1o transfer inf
* AhctractCollection .. s Provides inerfaces and cl4
* AbstractColort hQQﬁEEEﬂI]ﬂ prva il ot Provides classes and Inké
* AbstractDocument jirvaawTgeam Provides the Java 2D clasy
o Absprges Decment, AtrributeC - Brmidies classss and ke

The opening page of the javadocs consists of three frames as shown above. It allows you
to navigate through the hierarchy of classes in the APl by class name or by package.
(Mote: you leam about packages later in this course)

2. Using the Packages frame, select the java.lang package. The All Classes frame now
changes to display only classes within that package.

3. Find the Math class and dlick it to display its documentation in the main frame.
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JAVE AW TSP
Java awt umage

Java beang

Java beans beancontext
L

javalang -y—
javalang annotabion
Java lang instrument

£ 4 |

® ® ® & #® & & & # 4

java awtimage renderable

o

Overien  Package

Prev Class Next Class
Summary: Nested | Fisld | Constr | Method

Classes

Boolzan

Byla

Characler

Characler Subset
Character LinicodeBlock
Class

ClassLoader
Classyalue

Caompiler

Dioubla

Enum

Float
InheritableThreadLoca
Integer

Lo

ath —

Glags | Use Tree Deprecated Index Help

Frames Mo Frames
Dedsil Fighd | Conslr | Method

java.lang

Class Math

ava lang. Ohjact
Janra lang Math

public final class Hath
extends Cbhiject

The class Math contains methods for performing basic numene opera

Unlike some of the numeric methods of class Sericclach, allimpler
relazation permits better-performing implementations where strict repr

By default many of the Mach methods simply call the equivalent methiog
libraries or microprocessor instructions, where available, to provide hig
cohform to the specification for Math,

The qualty of implemeantation specifications concern twio properies, a
measured in terms of wies, units in the last place. For a given floating- |
oracketing that numarcal value. When discussing the accuracy of a md
army argument ITa method akyays ias an error less than 0.5 ulps, the 1
raundsd, A corractly round ed method is generally the best a Noaling-po
Instead, for the Math class, a larger eror hownd of 1 or 2 ulps is allowg

fho gvoet rgonild slhmaled b rgbirmad oot rormmdad rocnlt stngrides

Answer the following questions about the Math class:

a. How many methods are there in the Math class?
b. How many fields are there in the Math class?

Answer:
a.) 54
b.)2

Select several other classes in the Classes panel to answer this guestion: What class does
every class refer to at the top of the page? Hint: What class is the superclass to all

classes?

|Art5wer: Object

Find the String class and identify the methods of this class. Which methods enable you to

compare two strings?

[Amwer: compareTo and compareToIgnoreCase

Close the Practice06 project in NetBeans.
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